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A.  MANUAL INSTRUCTION FOR TriVista 577 RAMAN SYSTE M 
 
Software Settings  
 
1 Introduction 
 
The S&I software was written in order to obtain an optimised access to all three stages of the 
TriVista. It is programmed in "Visual Basic" and runs in co-operation with Princeton Instruments' 
WinSpec software package, which is designed to operate a multitude of CCD, ICCD and InGaAs 
detectors and allows access to exclusive detector functions. S&I software controls spectrometer 
functions while WinSpec is used as a DLL and provides data acquisition and setup functions for 
multi-channel detectors. Since these features are accessed by S&I, WinSpec must always be active 
when the S&I software is running. WinSpec is not required when data is acquired by a single-
channel detector such as a PMT, but the data will be stored in the WinSpec "SPE” format.  
Because WinSpec is used as a DLL, only some descriptions of the main functions of WinSpec are 
included in this manual. For more information, review the WinSpec manual.  
 
Apart from these two software packages there exist three more: 

o QED software for running and control of the optical camera 

o Stage Control software for the control of  XYZ motorized Stage, 
o Linkam software for the control of heating and cooling in Linkam microchamber. 

 
2. General Hardware Settings 
 
The first screen you will see after starting the S&I-software is the Measuring window. Because you 
will be entering, changing, or verifying the TriVista hardware settings, you must click on the 
Hardware button at the lower left of the window (see Figure 1). 
 

 
 

Figure 1. Window Displayed at Startup of the S&I Software 
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The Hardware window contains the System Settings table (automatically accessed by the program), 
displays descriptions of the currently selected measuring mode, and shows the current hardware 
configurations of the three stages (Fig.2). 
 

 
 

Figure 2. System settings within the Hardware window 
 

Any of the currently defined modes can be selected and used to acquire data, but changes to 
hardware settings are password-protected. For details you can see original TriVista System Manuel. 
 
3. Generating Different Configurations 
 

Use the "System Settings" button (lower left) to switch to the main Hardware window. As shown in 
Figure 3, you will find a window that is divided into three panels:  

• Main setup properties on the left side,  

• Illustration of the optical path in the center, and  

• Individual stage settings on the right side  

 

 
 

Figure 3. System Settings window 
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Every configured setup and every change within a setup has to be stored by using the "Accept 
Changes" button (right, bottom). To activate the stored settings, click on "Set Mode" or start data 
acquisition in the "Measuring" window.  

 
3.1 TriVista Configurations 
 
Each configuration of the system that you have stored can be recalled later by clicking on its name. 
Figure 4 shows of a list of such configurations. The setups differ from each other in the following 
ways: 
 

o Mode (Figure 5), 
o Method for detection (CCD, PMT), and 
o Choice of gratings. 

 

 
 
Figure 4. List of TriVista Configurations 
 
 
 
3.2 Setting Main Properties 
 
The first step to generate a new device configuration is to set the main properties. Therefore, you 
click the "New" button and: 

o Enter a configuration name, 
o Select a detection method, and 
o Select a mode for the spectrometer system. 

 
To correctly configure the chosen "Mode", refer to the illustration of the optical path in the middle 
panel of the "System Settings" window. 
For details related to the settings of main properties you can see Paragraph 5.4.2. in original 
TriVista System Manuel. 
 
 

Figure 5. Mode Selection (depending on 7 
different ways of use of TriVista 
spectrometer) 
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3.3 Stage Settings 
 
"Stage Settings" is the last part of a system setup. The Stage Settings panel is at the right side of the 
"System Settings" window, as shown in Figure 54. For each stage it is possible to choose: 

o Which grating in which order shall be used, 
o The width of each slit, and 
o The offset of the stage (see below). 

 
Gratinqs and Order 
 
By selecting a grating you also define the dispersion. The higher the groove density of the grating, 
the higher the dispersion and the lower the CCD spectral coverage. Probable values for groove 
density of the gratings depend on the settings for the gratings that have been installed and set up in 
the "Monochromator Settings" window. It is also possible to define the order to be used for each 
grating. 

 
 
 
 
 

 

 

 

 
 
3.4 Slits 

Slit names and status (manual, motorized, or disabled) are determined by the entries made in the 
"Monochromator Settings" window. The default names of the slits are S 1 - 2 in Stage 1, S3 - 6 in 
Stage 2 and S7 -9 in Stage 3. The active slits are represented in the "System Settings" window by 
the "Slit" fields (below the "Offsets" field in each stage). The function of the field depends on 

Tips: 
1.  Subtractive mode is only possible if the groove density of the first two stages is 
the same. If it differs, the dispersion can not be inverted correctly. 
2. To illuminate the whole CCD chip, the groove density of the last stage should be 
twice of the groove density in the first two stages in mode "Triple Subtractive". 

 

Figure 6. Stage Settings 
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whether the slit is manual (for example, an entrance slit) or motorized (for example, an intermediate 
slit):  

• If the slit is manual, the field allows you  to enter the current slit-width for a manual slit as a 
comment or reminder of the slit-width it has been set to. 

• If the slit is motorized, entering a slit width sends a command to actually change the slit-
width. The range of width values for a motorized slit is 10 - 12000 pm. 

 

 
Figure 7. Slit Settings in the 3rd Stage 

 

 
 
3.5 Offsets 
 
"Offset (nm)" fields in "Stage-Settings" are used for setting of offset values for the optimisation of 
accordance between stages and given application request.  
 

     Figure 8. Offset (nm) Setings 

TIPS: 

• To keep stray light at a low level, all slits that are not used in the current setup (for example the 
intermediate slits, when only one stage is used) should be closed. 

• Resolution always depends on the slit-width of the entrance slit. In "Triple Subtractive" mode, 
the second intermediate slit works as an entrance slit. 

• When using a PMT, the intermediate slits should be narrow for stray light rejection but can be 
opened up to 150 pm. 

• For standard applications with a CCD camera we recommend to use the following slit-widths: 

•  
Mode Intermediate Slit 1 [µµµµm] Intermediate Slit 1 [µµµµm] 

Double Additive 12000 0 
Double Subtractive 12000 0 
Triple Additive 6000 12000 
Triple Subtractive 12000 As Entrance 

Table 1. Mode vs. Intermediate Slit Width 
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CAUTION  
 
 
 
 
Additional settings that are shared by all generated configurations are defined in the "Global 
Settings" window and described in the Paragraph 5.4.6. in original TriVista System Manual. 
 
 
 
B. INSTRUCTIONS FOR MEASUREMENTS  
 
1. Beginning with measurements 
 
When all the settings are performed and there is nothing left to be changed one can begin with 
measurements. After running S&I software from Measuring Window on the right screen, run 
programme WinSpec. WinSpec window will appear on the left screen (see Figure 8).  
 

 
 

Figure 9. WinSpec window 
 
1.1. Cooling of the detector 
 
Prior to measurements check the temperature of CCD detector cooled with liquid nitrogen whose 
working temperature is -122 oC. Open the falling menu Setup In the WinSpec window and click on 
Detector Temperature (Figure 9, left). A new window will appear (Figure 9, right) where the 

The adjusted offset-position is only valid for the current grating and current wavelength! 
Note that the values in the offset-table in the "Monochromator Settings" window are set 
for the whole spectral range of the grating and not for a specific wavelength. Matching 
stages is explained in “5.6. Matching  the stages”. 
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present temperature of the CCD detector can be read. If the read temperature is higher than the 
working temperature (122oC) liquid nitrogen can be poured into the detector reservoir. 

 
 

 
 
 
 
 
 

 
Figure 10. Setup menu (left) and a window with detector parameters (right) 

Nitrogen is poured from the liquid nitrogen reservoir (Figure 10, left) using yellow tap on the left. 
The use of protection gloves is necessary. Nitrogen is first poured to the small metal reservoir and 
then from this reservoir to the detector with the use of filler cap. 

 
 
 
 
 

 
 
 
 
 
 
 

 
Figure 11. Large reservoir for liquid nitrogen (left) and protection gloves (right). 

 
1.2. Turning the laser on 
 
If the detector is cooled down to its working temperature the laser can be turned on. A combined 
Argon-Krypton (Ar+/Kr+) laser from the next-door Micro Raman laboratory (along with Jobin Yvon 
T64000) is used. Laser beam is directed by beam splitter (transmitting  50% of the output laser 
power in both directions) through the hole in the wall to the laboratory with TriVista system, and 
then is led with the series of mirrors to the TriVista microchamber entrance. 
 
1.2.1. Turning the laser cooling on 
 
Tips: LASER PURE 20 cooling system is used for cooling of the magnet in the laboratory with 
TriVista spectrometer, which is why special attention should be paid to prevent shut down of the 
cooling system which could cause the damage to the magnet. 
 
1. Turn on the tap on the water pipe if it is not already opened; 
2. Turn on POWER button on cooling system box  (LASER PURE 20) if it is NOT turned on; 
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3. Turn on the taps that two black pipes 
are connected to (i.e. turn them to 
horizontal positions); 

4. During an experiment the pressure 
and temperature of the distilled water 
in the closed system should be 
controlled at the appropriate meter    
Pressure on this meter MUST NOT 
get higher than 2.6 bars because it 
can damage pipes in the mere laser. 
Pressure on this meter MUST NOT 
get beneath 2 bars because the laser 
overheats in that case and shuts 
down automatically. 

 Temperature on the meter is usually around 22 oC. 
 
1.2.2. Turning on the laser feeding 

1. Turn the transformer on (Figure 12, left) by turning it to the position 1 ; 

2. Turn on the laser feeding box (Figure 12, right) (which lies under the table where the T64000 
Raman system is placed) turning the key on the box to ON position after which two lamps 
should turn on (green light). 

 
 

 
 
Figure 13. 
Transformer (left) and 
laser feeding box 
(right). 
 
1.2.3. Turning the 
laser beam on 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 14. Laser control unit. 
  
 

1. ON/OFF button 
2. LASER EMISSION 

signal lamp 
3. power control buttons 
4. configuration settings 

button 
5. back button 

1. 

2.. 

3. 

3. 4. 5. 
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When the laser feeding on the control box screen appears the following text: 
LASER OFF                               CUR 0.0 

 
1. Press the ON/OFF button (1.) on the control box; 
2. Laser needs 60-70 seconds to start lasing, if the emission doesn't start after this period 

nor after possible announced delay (~20s), TURN THE LASER OFF BY PRESSING 
THE ON/OFF BUTTON AND TURNING BACK THE KEY ON THE F EEDING 
BOX, THEN ASK FOR HELP ! 

3. When the laser starts lasing the signal lamp LASER EMISSION (2.) turns on and the 
following line appears:   

 
  10.0 A      0.000 W       CUR ; 
 

4. Using the upper and the lower power control button (3.) laser output power can be 
changed. 

 
1.2.4. The choice of laser line wavelength  
       

1. Changing of the laser line 
wavelength can be performed by 
rotation of two screws at the back 
of the laser box. These screws 
should be rotated until the maximal 
laser power is acquired (this can be 
read on the laser control box 
display) for the chosen laser line. 
The upper screw serves for 
approximate adjustment and the 
lower one for fine adjustment. 

2. In order to set the wavelength value 
of the chosen laser line press 
SELECT (4) button, find the option  

 
 
 LASER LINE by pressing button (3), then confirm your choice with button (4). Pressing the 

button (3) find the appropriate wavelength value, confirm it with button 4. Use button (5) to 
return to the menu.  

 

λ [nm] p [W] 

457,9 0,15 
465,8 0,04 
472,7 0,05 
476,5 0,30 
488,0 0,70 
514,5 0,80 
530,9 0,20 
568,2 0,5 
647,1 0,35 

 
Table 2. Ar+/Kr+ laser line wavelengths and appropriate maximum output laser  powers for the corresponding  

wavelengths 

              Figure 15 . Laser backside 



 

Institute of Physics - Belgrade - Center for Solid State Physics and New Materials The Sixth Framework Programme for Research and Technological Development 
12 

 

 
1.2.5 Turning the laser off 
 
Laser can be turned off by performing series of operation in the inversed order from the order they 
were performed in when laser was turned on: 

1. Decrease laser power to minimum. 

2. Press ON/OFF button. 

3. WAIT FOR TEN MINUTES FOR LASER TO COOL DOWN. 

4. Turn the feeding box off. 

5. Turn the transformer off. 

6. Close the taps connected to black pipes from laser cooling system. 

7. DON’T TURN OFF THE COOLING SYSTEM IF IT IS USED FOR COOLING OF THE MAGNET.  
 
1.3. Adjusting the sample position  
 
1.3.1. Microscope 
 
Olympus BX 51 (Fig.16) microscope is a part of micro-Raman spectrometer. This microscope 
operates using the confocal microscopy principle. Laser beam is led by the set of mirrors to the 
micro-chamber entrance (Fig.17). In the microchamber the beam is led to the semi-transmitting 
mirror where the part of the beam is reflected and led to the objective which focuses it on the 
sample. The sample is placed on the horizontal surface beneath the objective (Fig. 16). Back-
scattered radiation is focused by objective on its way back to the semi-transmitting mirror where it 
is transmitted and led by a set of mirrors to the entrance of the TriVista first Stage.    
 

 

 
 

Figure 16. Microscope Olympus BX 51 Figure 17. Microchamber and its elements 

 
 

WARNING!! IONIC LASER MIGHT BURN THE CLOTHES, FINGERS AND CAUSE 

PERMANENT EYE DAMAGE. DO NOT PUT SHINY OBJECTS IN THE LASER BEAM 

PATH. BEWARE WITH MIRRORS ADJUSTMENT. PERFORM BEAM FOCUSING AT 

SMALL LASER POWES LASERA. BE CAUTIOUSI! 

semi-
transmitting 
mirror 

optical path leading to 
TriVista triple 
monochromator 

path leading to 
objective 

entrance to the 
microchamber 
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Sl. 18 Linkam heating/cooling stage 

 
 
 
 
 
 
Linkam heating/cooling stage is used for Raman 
measurements at the temperatures below or 
above room temperatures (Fig.18). The sample 
is placed in the stage chamber, beneath the 
optical window. Objectives with longer focal 
length are used in such a case.  
 

 
 
1.3.2. XYZ Microscope Stage 
A sample may be moved in x, y or z directions either manually or using XYZ motorized Stage. 
Sample is moved in x and y direction with the help of metal screws on the sample holder edges. 
One big and one small black screw on the right side of the microscope are used for moving the 
sample along with sample holder in z direction (Fig.19). The big screw serves for movements with a 
large step and the small one is used for finer position adjustments.  
 

 
 

Figure 19. Microscope elements 
 
Sample positioning in xy plane is performed with motorised XYZ Stage, either by joystick or by 
setting of the appropriate values in the programme Stage Control. Pressing the button on the top of 
the joystick enables quicker moving of the Stage. The finest z position adjustments are performed 
with a small black screw on the right side of the joystick holder (Fig. 20). 
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Figure 20. Joystick of the motorised XYZ Stage 
 
Motorised XYZ Stage can be also used for scanning of the sample along x, y and z axes. Raman 
spectra can be taken from different spots, with a predetermined spatial step using the programme 
Stage Control. Details of the procedure are described in Stage Control Manual.  
 
Programme Stage Control has an Autofocus option, which enables the system to find the focus 
position itself (that is the position characterised by highest Raman signal intensity) in the 
predetermined z-axis range. Starting positions and used step are set in the programme Stage 
Control. Details of the procedure are described in Stage Control Manual.  
 
1.4. Focusing of laser beam on a sample 
 
After a sample is placed on the sample holder microscope lamp (Fig. 19) is turned on. Circular 
button with positions numbered from 1 to 6 (Fig. 19) should be turned to position 1 (only in this 
position light of the lamp reaches the sample). Metal bar above  the wheel is pushed in (activation 
of the camera) (Fig. 19).  
Programme QED Capture is run by clicking on its icon on the right screen and its active window 
appears on the left screen. In the lower right corner of the screen there is a LIVE button, clicking it 
shows camera's picture of the laser spot on the sample (Fig. 21a).  
 

 

1.1. Figure 21a. Laser spot on the sample recorded by camera 

 

button for quicker stage 
movements 

joystick for movements in 
xy plane 

black screw for fine 
adjustments of z position 
pomeranje duž z ose 
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A sample is positioned below the objective in the abovementioned way. One of two objectives with 
magnifications 20x or 100x is chosen. Moving the sample holder in z direction the focus position is 
reached which results in the appearance of the picture of the sample surface on the screen (Fig. 21b) 
if the laser power is decreased enough.  
 

 

1.2. Figure 21b. Sample surface recorded by camera connected to the microscope 

TIPS: Due to high intensity of laser radiation compared to the intensity of microscope lamp laser 
spot on the sample is shown on the screen when the camera is on. It is therefore necessary to 
decrease laser power, put some obstacle on the laser beam path, in order to see the picture of the 
sample surface with the camera. 
 
After focusing of the beam is performed circular button is turned to position 6, the metal bar is 
pulled out (Fig.19) and one can begin with collection of the Raman spectra. 
 
 
2 Data Acquisition 
 
To perform an acquisition, click on the “Measuring” button to open the Measuring window (Figure 
22). 
 

 
 

Figure 22. Measuring window 
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2.1 Global Settings and Commands 
 
At first you need to choose one of the configurations that have been generated in “System Settings”. 
The list of the configurations will appear by clicking the arrow at the first combo box in the 
“Settings” region. 
 

 
 
Figure 23. Selection of a Setup 
 
Independent from the chosen configuration it is possible to define the way the units of the spectra 
are displayed at the bottom of the measuring window. As Figure 60 shows it is possible to choose 
between:  

• Wavelength [nm], 

• Absolute wavenumber [cm-1], 

• Relative wavenumber [cm-1] and 

• Energy [eV] 
 
If the selected units are either "Relative Wavenumbers" or "Energy", you also have to enter the used 
laser wavelength at the third field within "Settings" so the software can perform a correct 
calculation of the dispersion with reference to the stimulation energy or wavelength.  
 
 
 
 
 
 
 
 
 
 
Figure 25.  Start and Stop buttons 
 
To start a measurement, click on the "Start" button. While the measurement is in progress, you can 
interrupt the measurement by clicking on the "Stop" button. The system will finish the actual data 
point of the measurement and stop. When you click the "Stop Button", the software will ask you if 
you really want to Stop or to Continue. If you stop a measurement, you will not lose the data that 
you have already taken. 
 

Figure 24. Display units 

 

Figure 26.  File menu 
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To save an acquired spectrum, click "File" and "Save File" as shown in Figure 62. Measurements 
with a CCD camera can also be stored through "WinSpec". To open a stored spectrum, use "Get 
File".  
 
Caution: For spectra that are measured with a CCD camera "Get File" is only able to transfer 
measuring data from WinSpec to the S&I software. Such spectra have to be opened by WinSpec 
first.  
 
The File menu also allows you to store the measuring settings for each specific setup in "System 
Settings". To save the settings for a setup, click "Save Mode". "Clear Mode" stores the settings of 
the last measurement that is done in the current mode. 
 
 
2.2 Data Format and illustration 
 
A spectrum is always stored as an "SPE" file. This type of file contains a header (with information 
about the measurement properties) and the data. To view the properties, switch to WinSpec, select 
the "File" menu, and then select "File Information" as shown in Figure 27.  
 

  
Figure 27. Item "File Information" in 
WinSpec 

Figure 28.  File Information dialog (in WinSpec) 

 
Then a popup dialog box will appear as Figure 28. Details related to this dialog box can be found in 
the paragraph 5.5.2 in the original TriVista System Manual. 
 
An acquired spectrum can be zoomed by using the magnifying glass (Figure 29.) at the lower right 
corner of the Measuring window. Changes of the zoom-factor never cause loss of data.  

   Figure 29. Zooming 
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2.3 CCD Detector and WinSpec 
 
If "CCD" is chosen as measuring method in the setup, "CCD-Settings" will appear at the top of the 
panel. 
 

 
 
Figure 30. Settings for CCD Measurements 
 
The name of the top field changes depending on the selected "Display Units" (chosen in the 
"Settings" panel). This is the field where you enter the center wavelength for your measurement. 
Below this field, you will see the calculated spectral range that will illuminate the CCD (this 
dispersion is calculated by the software from the focal length, inclusion angle, and detector pixel 
width entered in the "Monochromator Settings window). When you start the experiment, you will 
get a spectrum on the CCD whose resolution depends on the properties of your setup in the "System 
Settings" window. In the "Accumulations" field, you enter the number of exposures for the 
measurement of one spectrum. In the "Exposure Time" field you enter the illumination period for 
each exposure. These two values can also be defined through Winspec. 
To move the system to a new center wavelength only, without taking a spectrum with the CCD, 
activate the "Set Hardware Only" checkbox. If you activate the "Run Focus" checkbox, clicking on 
the "Start" button will cause the system to take spectra in "Loop Mode" until you click on the 
"Stop" button. The "Run Focus" function should be used for alignment of the system or the sample. 
If "Run Focus" is not activate, the system takes only one spectrum with the given exposure time and 
the number of accumulations. During the acquisition, the spectra are also displayed in the WinSpec 
software. To monitor the acquisition, click on the "WinSpec/3ZM button and you will be in 
WinSpec. 
 
 
 
 
Data acquisition with CCD or Array detectors is controlled and done trough WinSpec. For 
that reason, the general properties of the detector and the acquisition mode have to be defined 
there. For detailed procedure of detector properties definition you can refer to the Paragraph 
5.5.4 in the original TriVista System Manuel. 
 
2.4. Measurement Parameters in WinSpec 
 
Nearly all parameters for the data acquisition with multi-channel detectors can be set in menu 
"Experiment Setup" dialog box (menu item "Acquisition", then "Experiment Setup"). Only 
"Exposure Time" and "Accumulations" are controlled through the S&I software (beginning 
of this chapter). 
 

TIPS: If WinSpec isn’t running click on "WinSpec/32" icon before pressing "Start" button. 
Click on "Start" to begin with data acquisition. 
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Figure 31. Experiment setup in WinSpec 
 
To understand the use of the "ADC", "Timing", "Process", "Save&Load" and "Data Corrections" 
tab pages, refer to the WinSpec manual. All parameters in WinSpec need to be set according to your 
experimental requirements. To take a picture with the detector, choose "Use Full Chip" at "CCD 
Readout". When measuring spectra, select "Use Region of  Interest".   
 

 
 

Figure 32. Format of Measurement Data 
 

TIPS: To save time during measurements, 
you may want to deactivate the checkbox 
"Confirm before overwriting" (in the 
"Overwrite and Append" section).  
 

The "Data File" (Figure 32.) parameters 
are also described in the WinSpec 
manual. For data acquisition through 
the S&I software "Data Type" must be 
set to "FLOAT"! All other data types 
are not supported.  
 

Setting up an "ROI" (Region Of Interest – Figure 33) can be used to optimize the spectral data that you 
will acquire. 
 

• For maximum intensity the full height of the CCD may be "binned" (gathered) into one super 
pixel. 

• To minimize the effect of dark charge and keep the background signal as small as possible, you 
can specify that only the illuminated area of the CCD be read out. CCD systems with less 
efficient cooling may have a relatively large dark charge, especially with increasing exposure 
time. 

• To read out the whole chip, click on the "Full" button. 
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Figure 33. Region of Interest for CCD chip 
 
 
Never forget to use button "OK" after setting the Chip parameters. 
 
 
2.5 Conversion of the collected spectra to ASCII format 
 
Collected spectra can be converted to a text file, which is convenient for use in other programmes 
for results analysis (i.e. Microcal Origin). 
The conversion of the files containing spectra is done in WinSpec programme. Open Tools menu 
and choose Convert To ASCII option (Figure 34a).  

 

 
 

 
 

 

 
Figure 34.(a) Convert to ASCII option 

 

A window will be opened (Fig. 34(b)) with help of which a 
spectrum maybe converted to the required format.  
Fig. 34(b) shows a choice of parameters used to convert a 
spectrum to two columns, divided by Space, first contains 
values of Raman shift in rel. cm-1 (Pixel), and the second 
one corresponding signal intensities (Intensity). 
Tip : More spectra may be converted in the same time. 
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2.6 Collecting Raman spectra in wider range – Step & Glue mode 
 

If there is a need for Raman spectra to be collected in wider range from the one determined by 
chosen combination of gratings in three Stages of TriVista system, Step&Glue mode entailed in 
S&I programme should be used. 
 
While running S&I software, press “Step & Glue” icon at the left side of Measuring window 
(Figure 22). Measuring – Step & Glue window (shown on the right side of the Figure 34) will 
appear on the right screen. On the left screen WinSpec/32 window should remain active.  
 
Input of the following parameters of the measurement should be made into the fields on the right 
screen: 

o Units (rel. cm-1, nm, …), 
o Range (From, To) in the set units, 

o Overlap between the subsequent regions spectra are taken in expressed in percents, 

o Accumulations,  
o Exposure time. 

 
When the mentioned parameters are chosen, one can start the measurements by pressing Start 
button in the upper right corner of the right screen. On the left screen, in WinSpec window, parts of 
the collected spectrum that is being taken at the given moment will be shown.  
After the performed measurement spectrum should be saved in regular way. 
 
 

 
 

Figure 34. Windows shown during measurements in “Step&Glue” mode 

 
 
3 Matching the Stages 
 
Within the S&I software, there are two different locations that you need to access when matching 
the different stages: the general "Offset Table" in "Monochromator Settings" and the "Stage 
Settings" for a specific measurement mode. The matches are stored as "Offsets", which means an 
additional movement of the turret to the correct position.  
 
The Offset Table in the "Monochromator Settings" Window is described in detail in 
Paragraph 5.6.1 of the original TriVista System Manuel. 
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3.1 Stage Settings within the "System Settings " window 
 
"Stage Settings" in "System Settings" window are accessible by every user. The offsets in "Stage 
Settings" are specific values for only one specific configuration and only a specific wavelength 
range. If you change a grating, the position of one of the diverter mirrors, or change the wavelength, 
the values are no longer appropriate and you have to enter the new values for the new setup. 
 
3.2 Matching - through "Advanced Slit Commands " 
 
To execute the matching, it is necessary to start a measurement in "Run Focus" mode. This 
operation is only possible while a running measurement. The locating of the offsets occurs through 
"Advanced Slit Commands" on the "File" menu (Figure 34).  
 

 
 
Figure 34. Item “Advanced Slit Commands” 
 

 
 
Figure 35.  Menu “Advanced Slit Commands" 
 
In this dialog box, you have access to all motorized slits and to all turrets and can move all of them 
separately. You have two ways to enter or change a slit width or an offset position: 

1. Enter absolute values in the input fields and execute the command by clicking on the "Move" 
button. 

2. Use the arrow buttons to the right of the "Move" button. The effect of the buttons on the current 
value is: 

 <I>: Changes the value +/- 10 pm for the slit-width and +/- 0.01 nm for the wavelength 

 << I >>: Changes the value +/- 100 pm for the slit-width and +/- 0.1 nm for the wavelength 
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 <<< I >>>: Changes the value +/- 1000 pm for the slit-width and +/- 1 nm for the wavelength 

 

 
Matching should be carried out in the following order: 

1.  Positioning Stage 1 

 a. The entrance slit should be opened to 10-20 µm. All other slits that pertain to the  current 
configuration should be completely opened. 

 b. Then, the first intermediate slit should be as narrow as possible to irradiate the  second 
stage. 

 c. Next, Stage 1 has to be moved to the position where maximum intensity is  displayed at the 
PMT or the CCD chip. 

 d. Step b and Step c should be repeated until only one position of Stage 1 leads to  maximum 
intensity. 

 2.  Positioning Stage 2 
 a. The positioning of Stage 2 occurs in the same way as in Stage 1 but with closing  the 

second intermediate slit instead of the first one. 

 b. The grating in Stage 1 must not be moved while matching Stage 2. 
3.  Positioning stage 3 

 a. If the positioning of Stage 3 occurs with a PMT at the exit slit, the exit slit 

  should be as narrow as possible to irradiate the PMT. 
 b. The intermediate slits can be reopened to measuring conditions. When using a  CCD you 

must move Stage 3 until the peak of the waveIength corresponds to the central wavelength that 
is set in CCD-Settings in the "Measuring" menu. 

 c. The gratings in Stage 1 and Stage 2 must not be moved while matching Stage 3. 

If "Display Units" is set to "abs. wavenumbers" or "rel. wavenumbers", the region "Stage Offset" 
will change to relative wavenumbers (unit : cm ). 
 


